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chapter 1

Installation and Authorization
DigiTranslator™ 2.0 option lets Pro Tools ex-
change audio and video files, and sequences 
with other AAF and OMFI-compatible applica-
tions.

Installing DigiTranslator

To install DigiTranslator:

1  Insert the Pro Tools Installer CD-ROM and 
double-click the installer icon.

2  When prompted, select Custom Install, en-
able the DigiTranslator 2.0 Option, and com-
plete the installation, following the on-screen 
instructions.

Authorizing DigiTranslator

iLok

DigiTranslator 2.0 is authorized using the iLok 
USB Smart Key from PACE Anti Piracy. One iLok 
USB Smart Key is included with your Pro Tools 
system. This key can hold over 100 authoriza-
tions for all your iLok-enabled software. Once 
iLok is authorized for a given piece of software, 
use iLok to authorize that software on any com-
puter.
The iLok is authorized using License Cards. Li-
cense Cards are specific to each Pro Tools option 
or plug-in you purchase.

To authorize iLok:

1  Insert the iLok into an available USB port on 
your computer.

2  Launch Pro Tools. You will be prompted to au-
thorize the DigiTranslator 2.0 Option.

3  Follow the on-screen instructions until you 
are prompted to insert the DigiTranslator 2.0 Li-
cense Card into the iLok.

4  Separate the License Card from the larger pro-
tective card by pulling the cutout up and out 
with your thumb. Do not force your finger 
downward.

If you are already using the DigiTranslator 
2.0 Option in Demo mode, launch 
Pro Tools before you insert the iLok, then 
insert the iLok into any available USB port 
when prompted by Pro Tools.
Chapter 1: Installation and Authorization 1
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5  Insert the License Card into the iLok. You will 
be able to visually verify that the License Card 
makes contact with the iLok’s metal card reader.

6  With the iLok inserted in any available USB 
port on your computer, click Authorize.

7  After authorizing, remove the License Card 
from the iLok. (If you have to remove the iLok 
to remove the License Card, be sure to re-insert 
the iLok in any available USB port on your com-
puter.)

Key Disk Authorization
(Pro Tools 5.1.3 Only)

If you already own the DigiTranslator option, 
you can use your Authorizer diskette to autho-
rize or deauthorize DigiTranslator. After you in-
stall the software from the Pro Tools Installer 
CD-ROM, the Authorizer diskette permits you to 
authorize and use a single copy of DigiTransla-
tor.

To authorize or deauthorize DigiTranslator:

1  Insert the Authorizer diskette into the floppy 
drive. (Pro Tools should NOT be launched dur-
ing this process).

2  Click Authdeauthorizer in the pop-up win-
dow that appears. 

3  Click Set-up Authorizer or Deauthorizer.

iLok with License Card
DigiTranslator Integrated Option Guide
4  Choose Authorize or Remove.

5  Select disk location and click ReAuthorize or 
Remove. 

6  Click Quit.

DigiTranslator Demo Mode

To use DigiTranslator in demo mode:

1  Launch Pro Tools. A dialog will appear, asking 
if you would like to start your demo period of 
DigiTranslator. 

2  Click Try It.

The first time you launch Pro Tools after the 
demo period has ended, a dialog indicates that 
your DigiTranslator demo has expired. You will 
need to authorize the DigiTranslator option at 
this time to continue using DigiTranslator. 

If you do not authorize the DigiTranslator op-
tion at the end of the demo period, you will en-
counter the copy protection warning dialog ev-
ery time you launch Pro Tools. If you do not 
intend to authorize the DigiTranslator option 
on your system, you should uninstall DigiTrans-
lator.

If you are using the correct key disk, you will 
see a gold key icon. However, if you are re-
moving an application and a “?” appears 
over the application icon, the diskette you 
inserted is not the one you originally used to 
authorize the application. If you then con-
tinue through the deauthorization process, 
the application will be deauthorized, but 
the authorization will not be credited back 
to the diskette for your next installation.



            
Uninstalling DigiTranslator

To uninstall the DigiTranslator option:

■ On Windows, use the Add/Remove Programs 
control panel to modify the Pro Tools installa-
tion. Deselect the DigiTranslator option, click 
Next, and then click Finish.

■ On Macintosh, it is recommended that you 
delete the OMF.dll file from your Pro Tools 
folder by dragging it to the trash.

Compatibility
Digidesign can only assure compatibility and 
provide support for hardware and software it 
has tested and approved. 

For a list of Digidesign hardware systems, 
Digidesign-qualified computers, operating sys-
tems, and third-party devices and software, refer 
to the latest compatibility information available 
on the Digidesign Web site (www.digide-
sign.com/compato).

DigiTranslator 2.0 supports OMFI version 2 files. 
OMFI version 1 files are not supported.

AAF import and export is only supported in 
Pro Tools 6.1. Earlier versions of Pro Tools do 
not support import or export of AAF.
Current Supported Systems

The following Pro Tools systems are compatible 
with DigiTranslator 2.0, and are covered in this 
guide:

• Pro Tools TDM 6.1 for Windows XP and Mac 
OS X

• Pro Tools LE 6.1 for Windows XP and Mac OS 
X

• Pro Tools TDM 5.3.3 for Windows XP 

• Pro Tools LE 5.3.2 for Windows XP

• Pro Tools|HD 5.3.1 for Mac OS 9 

• Pro Tools|24 MIX 5.1.3 for Mac OS 9
Chapter 1: Installation and Authorization 3
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chapter 2

AAF and OMFI Overview
Advantages of AAF and OMFI
Advanced Authoring Format (AAF) and Open 
Media Framework Interchange (OMFI):

• Eliminate the need for tape-based file trans-
fers. Once media files and compositions have 
been created by one user, they can be made 
available to other collaborators.

• Add flexibility by enabling the free exchange 
of projects between multiple, specialized 
tools, with media and composition compati-
bility. 

• Retain the highest picture and sound quality 
with all-digital file transfers.

• Eliminate redundancy by preserving format-
ting information—timing, sync positioning, 
layering, and effects—when moving projects 
between applications and different worksta-
tions. 

• Eliminate the need to rebuild sequences and 
elements from scratch when changing appli-
cations. 

• Increase creativity and productivity by en-
abling professionals to spend more time on 
creative aspects of the process and less time 
on media management headaches.
About OMFI

Open Media Framework Interchange (OMFI) is 
an industry standard file format that facilitates 
the transfer of digital media between OMF-com-
patible applications.

OMFI is used in the creation of feature films, 
trailers, television programs, commercials, doc-
umentaries, and other programs. Leading broad-
casters, post production houses, and motion 
picture studios have chosen OMFI as the trans-
fer mechanism in an integrated, all-digital post 
production workflow. All steps of the creative 
process are linked together digitally through 
OMFI.

About AAF

The Advanced Authoring Format (AAF) is a new 
(2001) multimedia file format that enables con-
tent creators to easily exchange digital media 
and metadata across platforms, and between 
systems and applications. The AAF simplifies 
project management, saves time, and preserves 
valuable metadata that was often lost when 
transferring media between applications in the 
past. AAF supports a broad range of “essence” 
Chapter 2: AAF and OMFI Overview 5
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(media) file formats, including OMFI video and 
audio, allowing for the easy interchange of me-
dia between multiple AAF-compatible applica-
tions.

AAF and OMFI Basics
AAF and OMFI are mechanisms for storing and 
retrieving media data and metadata so that 
projects can be freely exchanged between differ-
ent applications and platforms. In the simplest 
case of AAF and OMFI, only metadata is ex-
changed between applications.

Media data and metadata enable an application 
that receives AAF and OMFI files (such as 
Pro Tools) to automatically and quickly reas-
semble the composition. A simple metaphor for 
this approach is that media data files are the 
pieces of a puzzle and metadata is the set of in-
structions for assembling the puzzle.

Media Data (Media Files)

Media data represents raw audio or video mate-
rial and is stored in individual media files. Every 
time you record a piece of video or audio mate-
rial into an application, you are creating a media 
file containing media data. Audio media data is 
stored as “samples” (such as 44,100 or 48,000 
samples per second of recording) while video 
media is typically stored as “frames” (24, 25, or 
30 frames per second of recording). 

The size of each media file depends on how 
much audio or video material it contains. For 
example, if you record ten minutes of continu-
ous video material at a high resolution, you may 
end up with a video media file that is 1.8 GB in 
size, whereas a one minute recording at the 

For more information, see 
www.aafassociation.org.
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same resolution might result in a 180 MB file. 
Media files tend to be large, since high quality 
audio and video signals are data intensive. 
Video data generally requires considerably more 
storage than audio data.

Metadata

Metadata is used to describe:

◆ Information about each media file. This may 
include sample rate, bit depth, region names, 
the name of the videotape from which the me-
dia file was captured, and even time code values 
that specify where a file was used in a Pro Tools 
session.

◆ Information about Pro Tools sessions or other 
sequences, including what files are used, where 
they appear in a timeline, and automation.

◆ For AAF or OMFI sequences, information 
about unrendered AudioSuite effects (such as 
real-time EQ) on Avid workstations. Pro Tools 
skips unrendered effects on import. Rendered ef-
fects are media files, that can be imported or 
skipped on import into Pro Tools.

◆ For AAF or OMFI sequences, information 
about automation (clip-based gain or keyframe 
gain).



           
Pro Tools and Avid Terminology

Pro Tools and Avid use different terms to de-
scribe the same items. For example, a Pro Tools 
session is equivalent to an Avid sequence. The fol-
lowing table lists common Pro Tools elements 
and their Avid equivalents.

Pro Tools Avid (OMFI)

session sequence

whole file 
region

master clip

region subclip

plug-ins real-time audio effects

automation automation gain (clip-based gain 
or key-frame gain)

Whole audio files in the Regions List nor-
mally appear in bold type. However, master 
clip audio files imported from AAF or OMFI 
into Pro Tools will not appear in bold type 
(indicating regions) in the Pro Tools Re-
gions List even though they are audio files.
Chapter 2: AAF and OMFI Overview 7
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Embedded Media and External 
Media
There are two ways to handle media files when 
exporting OMFI files: Embedded Media and Ex-
ternal File References. 

Pro Tools with DigiTranslator does not 
support AAF files with embedded media. 
Pro Tools with DigiTranslator only sup-
ports AAF export with external file refer-
ences.
DigiTranslator Integrated Option Guide
Embedded Media
(OMFI Only)

Exporting to OMFI with embedded media re-
sults in one large OMFI file containing both the 
metadata and all associated media files. How-
ever, it is important to note that OMFI limits 
files sizes to 2 GB.
Figure 1.  OMFI Interchange Workflow with Embedded Media

Avid Workstation Edited Sequence

Embedded OMFI File (metadata and media)

Export OMFI with Embedded Media

Refers to:

Original Source Media Files

Sequence (metadata) Consolidated Media Files
(with Handle)

creates...



      
External File References

Exporting AAF or OMFI with external file refer-
ences results in a single metadata file (.aaf or 
.omf) and all associated media stored as separate 
files.

The main benefit to this approach is that fewer 
copies of media files may need to be made, so 
the export and import process can be much 
faster. Using this approach, it is less likely that 
you will encounter any file size limitations since 
the data is broken up into many smaller files.
The main disadvantage to this approach is that 
there are potentially many files (for example, 
one AAF or OMFI file and hundreds of media 
files) that must be transported between systems.
----
Figure 2.  AAF and OMFI Interchange Workflow with External Media

Refers to:

Refers to:

Re
fe
rs
 to

:

Avid Workstation Edited Sequence

AAF/OMFI File (metadata only)

Original Source Media Files

Translated Pro  Tools Session File

DigiTranslator Imports
Session File
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Audio File Format 
Compatibility Issues

 

AIFC Audio File Format

 

Avid Media Composer supports audio files in 
the AIFC format, a version of the Audio Inter-
change File Format (AIFF) that supports com-
pressed media. Pro Tools does not compress au-
dio in this file format, however Pro Tools can 
import and use this format.

 

Sound Designer II Audio File Format

 

SDII and MediaManager

 

You cannot check Sound Designer II (SDII) files 
into Avid Unity™ MediaManager (an AAF and 
OMFI compliant media database) from 
Pro Tools. Even though MediaManager supports 
SDII files, and SDII files checked in from an Avid 
video workstation can be imported into 
Pro Tools sessions, MediaManager will not rec-
ognize SDII files exported from Pro Tools. 

 

SDII and AAF

 

Pro Tools does not support the import or export 
of AAF sequences referencing Sound Designer II 
(SDII) files.

 

Enforce Mac/PC Compatibility

 

For the sake of optimal compatibility, always en-
able Enforce Mac/PC Compatibility in the New 
Session dialog. This ensures that all Pro Tools 
files are saved in the AIFF or BWF (.WAV) for-
mat, and that no illegal characters are used in 
file names. You can also configure existing ses-
sions to default to AIFF or BWF (.WAV) format, 
or convert SDII files upon export.
DigiTranslator Integrated Option Guide



chapter 3

Working with Avid Unity MediaManager
(Mac OS 9 and Windows XP Only)
     

Avid Unity™ MediaManager is an AAF and 
OMFI compliant media database that lets you 
search a large number of media objects (master 
clips, sequences, effects, and any other type of 
object that references digital media) in the Avid 
Unity MediaNetwork or MediaNet shared stor-
age environment.

MediaManager provides comprehensive facili-
ties for finding media objects stored in the 
MediaNet file system. You can also use Media-
Manager to manage sequences and other media 
objects whose media is no longer online. You 
can then search for these objects, view informa-
tion about them such as the source tape name, 
obtain the source footage, and rerecord or redig-
itize it.

MediaManager is easy to access and use. Its user 
interface opens in a standard Web browser and 
allows you to quickly search or browse its con-
tents for objects of interest. Drag and drop sup-
port allows you to add media objects to and ob-

            

For the most current information on com-
patibility between different versions of Avid 
Unity MediaNetwork or MediaNet and Me-
diaManager, and specific Pro Tools sys-
tems, visit the Digidesign Web site 
(www.digidesign.com/compato).
Chapter 3: Working with Avid
tain media objects from its database by dragging 
them from and to Avid system bins. You can 
also drag and drop sequences or media files into 
Pro Tools.

The MediaManager environment consists of the 
following functional components:

■ Unity MediaNetwork or MediaNet file server 
and storage

■ MediaManager to track and manage media

■ Supported Avid workstations (Media Com-
poser®, Symphony™, Avid Xpress®, NewsCut-
ter®, and Pro Tools workstations)

■ TransferManager system that will manage the 
transfer of media to and from the workgroup 
and to and from other workgroups and playback 
devices

■ A network that connects the Avid worksta-
tions, MediaManager server, and TransferMan-
ager server to the Avid Unity MediaNetwork 
environment
 Unity MediaManager (Mac OS 9 and Windows XP Only) 11
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You can add the following media objects to 
MediaManager from Pro Tools:

 

■

 

Master clip (equivalent to a Pro Tools whole 
file region)

 

■

 

Subclip (equivalent to a Pro Tools sub region)

 

■

 

Sequence (equivalent to a Pro Tools session)

 

MediaManager Setup and 
Operations

 

MediaManager is an Avid database product for 
tracking files on a MediaNetwork or MediaNet 
system. Pro Tools on Windows can interact with 
Avid MediaManager 3.0 or later; and Pro Tools 
on Macintosh (Mac OS 9 only) can interact with 
Avid MediaManager 2.5 or later. 

When MediaManager is used to check files into 
the MediaNetwork or MediaNet system, Media-
Manager can track how these files are referenced 
by other OMFI files and make them available for 
use with other projects.

To use MediaManager with Pro Tools, the Digi-
Translator 2.0 Option is required.

 

There are two levels of interaction between 
Pro Tools and MediaManager:

 
■

 The background connection. This is invisible 
to the user.

– and –

 

■

 

MediaManager’s browser interface. 

Both levels of interaction with MediaManager 
require their own login procedure. 

 

For more information about Avid Unity Me-
diaNetwork or MediaNet and MediaMan-
ager, visit the Avid Web site at 
www.avid.com.
DigiTranslator Integrated Option Guide
With the browser, you can:

 

■

 

Find files that are already checked in to 
MediaManager. 

 

■

 

Drag and drop files from MediaManager to 
Pro Tools.

 

With the background connection, you can:

 

■

 

Check files into MediaManager without 
launching the browser interface.

 

To log in to the browser:

 

1  

 

Launch the browser appropriate for your sys-
tem:

• Pro Tools 6.1 on Windows: Internet Ex-
plorer 6.0

• Pro Tools 5.3.1 or later on Macintosh: In-
ternet Explorer 5.0 or 5.1

• Pro Tools 5.1.3 on Macintosh: Netscape 4.7 
(Netscape 6.0 and 7.0 are not supported)

 

2  

 

Enter the name of the host for your database. 
If your system is set up in a non-standard con-
figuration, you may need to enter a URL. 

  

Netscape is not supported with Pro Tools 
5.3.1 or later.

For the latest compatibility information, see 
the Digidesign Web site at 
www.digidesign.com/compato.



3  Log on, using an authorized user name and 
password.

To set up and launch Avid MediaManager for a 
background connection:

1  In Pro Tools, choose File > Log In to Media-
Manager to launch the MediaManager Login di-
alog. 

2  Enter the name of the host for your database. 
If your system is set up in a non-standard con-
figuration, you may need to enter a URL. 

3  Log on, using an authorized user name and 
password.

MediaManager Log In

The MediaManager Log In menu item alternates 
between “Log In to MediaManager” and “Log 
Out of MediaManager,” depending on whether 
or not you are logged in.

If this menu item is greyed out, the DigiTransla-
tor 2.0 Option is either not authorized or incor-
rectly installed.

 MediaManager Login Dialog
Chapter 3: Working with Avid
             

The MediaManager Login dialog provides the 
following:

 

Host Name 

 

The host name is the name of the 
web server where MediaManager is installed. If 
your MediaManager administrator has chosen 
the standard configuration, you should only 
need to enter the host name. This field will re-
tain your entry for future use. 

 

URL 

 

If your MediaManager administrator has 
chosen the non-standard configuration, you 
may need to enter the entire URL. This field will 
retain your entry for future use.

 

Use Full URL 

 

If Use Full URL is checked, 
Pro Tools will use the entry in the URL field, and 
not the entry in the Host Name field. This 
checkbox defaults to the last setting used.

 

User Name 

 

Enter your user name in this field. 
User names are limited to 16 characters. This 
field defaults to the last user name entered.

 

Password 

 

Enter your password in this field. Pass-
words are limited to 16 characters. This field 
does not retain previous entries.

 

Log In On Launch 

 

When this box is checked, 
Pro Tools automatically launches the Media-
Manager Log In dialog whenever Pro Tools is 
launched, and you will need to enter your pass-
word and login. This box defaults to the last set-
ting used. 

 

Log In 

 

Clicking this button will tell Pro Tools to 
log in to MediaManager. If login was successful, 
the dialog will close and the settings will be 
saved.

 

Cancel 

 

This button closes the dialog without 
saving changes to the settings (except for the 
Log In On Launch setting).

 

 Unity MediaManager (Mac OS 9 and Windows XP Only) 13
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Error Messages

Host Not Found Indicates that either the server is 
not responding, or the URL or host is incorrect.

User Name/Password Not Found Indicates that 
the user name or password is incorrect or incom-
plete.

Checking Files into MediaManager

Files checked into MediaManager can be 
searched, sorted, and tracked by a variety of cri-
teria, including file name, project name, or the 
name of the sequence with which they are asso-
ciated. MediaManager can only track media or 
sequence files that reside on a MediaNet work-
space.

Checking a Sequence into 
MediaManager

To play a sequence that has been checked in to 
MediaManager, all media files referenced by 
that sequence must also reside on the same Me-
diaNet system. When exporting a sequence to 
MediaManager, Pro Tools with the DigiTransla-
tor 2.0 Option automatically ensures that all the 

You cannot check Sound Designer II files 
into MediaManager from Pro Tools. 
Though Media Manager supports SDII files, 
and SDII files checked in from an Avid 
video workstation can be imported into 
Pro Tools sessions, MediaManager will not 
recognize SDII files exported from 
Pro Tools. 

When creating sessions in a MediaManager 
environment, you should always enable En-
force Mac/PC Compatibility in the New 
Session dialog. You can also set up existing 
sessions to default to AIFF or WAV format, 
or convert SDII files upon export.
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necessary files are copied to the correct location. 
For more information on exporting a sequence 
to MediaManager, see “Export Selected Tracks as 
OMF/AAF” on page 34.

 

MediaManager File Display

 

Head Frame

 

Once a Pro Tools audio file is imported into 
MediaManager, it is represented in all three 
MediaManager display views with the standard 
waveform graphic as its Head Frame.

 

File Information Window 

 

MediaManager displays the following informa-
tion for media files exported from Pro Tools:

 

Name 

 

Displays the clip name as entered in the 
Publishing Options window. Clip names default 
to the name of the region as it appears in 
Pro Tools.

In the Finder, most AAF and OMFI files have 
long and somewhat cryptic names that guaran-
tee that each file can be uniquely identified by 
the computer. This makes identifying files at a 
glance difficult. However, AAF and OMFI clip 
names are displayed in MediaManager, making 
them more recognizable.

  

Head Frames

 

In Pro Tools 6.x, the DigiBase browsers’ 
Clip column displays the clip name of OMF 
media.



                                 
Type Displays three file types: sequence, master 
clip, or subclip. 

• A Pro Tools session is listed in this window as a 
sequence. This is the metadata of a Pro Tools 
session that has been saved as an AAF or OMFI 
file.

• A Pro Tools whole file region is listed in this 
window as a master clip. 

• A Pro Tools region is listed in this window as a 
subclip. 

In Pro Tools, the Export Selected as Files com-
mand exports regions as complete files. These 
appear as master clips with OMFI data attached. 

Creation Date Displays the date the file was ex-
ported from Pro Tools, not the date of the origi-
nal recording.

Modified Date Displays the date the file was up-
dated. This changes each time a change is made 
to the Comments field.

Check-in Date Displays the date the file was 
checked in to MediaManager.

Tape Name (Pro Tools 5.1.3) Displays (by de-
fault) the name of the originating Pro Tools ses-
sion. You can override this by manually enter-
ing a different tape name in the Publishing 
Options window during the export process.

Pro Tools Comment (Pro Tools 5.3.1 or 
later) Displays (by default) the name of the orig-
inating Pro Tools session. You can override this 
by manually entering a different Pro Tools 
Comment in the Publishing Options window 
during the export process.

Duration Displays file length in hours, minutes 
and seconds.

Created By Displays the user name of the person 
who checked the file into MediaManager.
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Referenced Displays “Yes” if the file is part of a 
sequence or master clip that is also checked into 
MediaManager.

Media Size Displays the file size.

Video Remains blank for any audio file exported 
from Pro Tools.

Expanded Information Window

Many of the parameters displayed in this win-
dow are set by MediaManager. However, the fol-
lowing should accurately reflect the sound file:

Audio Displays the Sample Rate.

Audio Format Displays the audio format (AIFF, 
BWF, and SDII).

Bit Depth Displays the bit depth.

fps Displays the frame rate (frames per second) 
chosen in the Publishing Options window.

Start Displays the original time stamp. 

Tracks Displays information about the tracks 
from which the audio was captured during digi-
tization process in Media Composer. Audio 
tracks are referred to as A1 through A8. 

Media Status Display

The colored status indicators display:

Green When media is online.

Red When media is offline.

Yellow When media was dragged from Media-
Manager and may require a transfer of media.

Blue When some related media are offline.
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Relatives

Subclips are considered “relatives” of their mas-
ter clips, and master clips and subclips that are 
used in a sequence are called “relatives” of the 
sequence. MediaManager can find and display 
all the relatives of a certain file or sequence. This 
makes it very easy to find all the media files re-
lated to a Pro Tools sequence which has been 
checked in to MediaManager.

Enforcing MediaNetwork or MediaNet 
Workspaces

All media files checked in to MediaManager 
must reside on a MediaNetwork or MediaNet 
workspace. If you attempt to save a file to a lo-
cation other than a MediaNetwork or MediaNet 
workspace, a warning message appears: “Media-
Manager files must be saved to a MediaNetwork 
workspace.” Click OK to return to the folder se-
lection dialog.

Avid Media Tool Support

Once you have checked files into MediaMan-
ager, you can view them with the Avid Media 
Tool if: 

• MediaManager is installed on your Avid sys-
tem. 

– and –

• You have used Bounce to Disk, Export Se-
lected as Files, or Export Selected Tracks As 
OMF.

– and –

• The files reside in the subfolder of the OMFI 
MediaFiles folder in the MediaNetwork or Me-
diaNet workspace.
DigiTranslator Integrated Option Guide
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Importing AAF and OMFI to Pro Tools
With DigiTranslator 2.0, you can import AAF se-
quences and OMFI media files and sequences 
(including those with embedded audio), into 
Pro Tools with the Open Session, Import Track, 
Import Audio to Track, and Import Audio (to Re-
gions List) commands. You can also drag and 
drop media or sequence files from MediaMan-
ager into a Pro Tools session (Windows XP or 
Mac OS 9 only). In Pro Tools 6.x, you can drag 
and drop OMF sequences or audio files from any 
DigiBase browser. In Pro Tools 6.1 you can also 
drag and drop AAF sequences from any DigiBase 
browser.

Opening an AAF or OMFI 
Sequence
You can import AAF or OMFI sequences directly 
into Pro Tools with the DigiTranslator 2.0 Op-
tion.

For more information about DigiBase, see 
the DigiBase and DigiBase Pro Guide.

Import from AAF to Pro Tools is only sup-
ported in Pro Tools 6.1.
There are two kinds of AAF and OMFI se-
quences:

• AAF and OMFI sequences that refer to other 
media files. 

• AAF and OMFI sequences that contain em-
bedded media. 

Pro Tools 6.1 can open AAF sequences that refer 
to other media files, but AAF sequences that 
contain embedded media cannot be imported 
into Pro Tools. If a known AAF sequence appears 
in a DigiBase browser as Kind Unknown, it is 
likely an embedded AAF sequence, or it was in-
correctly exported. Embedded AAF sequences 
are not supported in Pro Tools and conse-
quently cannot be imported.

In Pro Tools 6.1, when opening an AAF or OMFI 
sequence the New Session dialog opens, 
prompting you to name and save the sequence 
as a new session. Once you name and save the 
new session, the Import Session Data dialog 
opens. In the Import Session dialog you can 
configure DigiTranslator translation settings 
and other import options.
Chapter 4: Importing AAF and OMFI to Pro Tools 17



18
In Pro Tools 6.0 or 5.x, when opening an OMFI 
sequence, the New Session dialog does not ap-
pear, and DigiTranslator uses its default transla-
tion settings:

• Clip-based gain is ignored.

• Keyframe gain is preserved.

• Rendered AudioSuite effects are preserved.

• Unrendered AudioSuite effects are ignored.

If you have changed the default translation set-
tings, Pro Tools will use the last settings when 
opening an OMFI sequence.

For more information, see “AAF/OMFI Transla-
tion Settings” on page 24.

To open an AAF or OMFI sequence in Pro Tools:

1  Choose File > Open Session.

2  Select the AAF or OMFI sequence you want to 
import.

3  Click Open.

In Pro Tools 6.1, double-click the AAF or 
OMFI sequence that you want to import in 
any DigiBase browser.
DigiTranslator Integrated Option Guide
4  In Pro Tools 6.1, you will be prompted to 
name and save the imported sequence as a new 
session. After you click Save, the Import Session 
Data dialog opens. Select the session data, me-
dia, and import settings parameters you want, 
and click OK. For more information, see “Im-
porting AAF or OMFI Tracks into Pro Tools” on 
page 19.

– or –

In Pro Tools 6.0 or 5.x, you will be prompted to 
save the OMFI sequence as a new session only 
when you choose to save the session.

Once you have saved the new session, you may 
be prompted to do one of the following:

◆ In Pro Tools 5.x, if you are opening an OMFI 
sequence that contains embedded audio, you 
will be prompted to locate the embedded audio 
files. Select the OMFI sequence, and then click 
Open.

◆ If you are opening an OMFI sequence that 
contains embedded video, click Skip All when 
prompted to locate the video files.

When you are prompted to save the new ses-
sion, create a new directory (folder) and 
save the session to that directory. Pro Tools 
will create an Audio Files folder, a Fade 
Files folder, a Video Files folder, a 
cache.wfm file, and a session file in the 
same directory as the AAF or OMFI se-
quence.

Pro Tools does not support embedded video.



◆ If you are opening an OMFI sequence created 
on an Avid system you may be prompted to lo-
cate Fade files. It is recommended that you 
choose to Skip All Fades because fades created 
on an Avid system are not compatible with 
Pro Tools. Pro Tools always recreates all fades.

Multi-Cam Resolution Files

On an Avid system, Multi-Cam Resolution files 
display multiple individual camera angles of the 
same scene. The Avid operator chooses which of 
the Multi-Cam files (and therefore camera an-
gles) will be dominant, at the time of creating an 
AAF or OMF export. When you import an AAF 
or OMF sequence into a Pro Tools session, only 
the clip representing the dominant camera an-
gle will be displayed.

If there are any errors, region name trunca-
tions, or other notes (such as missing effect 
renderings), during the import, a dialog ap-
pears asking you if you want a detailed re-
port of the changes. Click Yes and choose 
where you want to save the log. The log is a 
text file that you can open in any text edit-
ing application.

Every AAF and OMFI file has a file name 
and unique identifier stored in the AAF and 
OMF metadata, and a name which is dis-
played in the finder. Truncating a region 
name in the translation process will not 
change the AAF or OMF file name or unique 
ID.
Importing AAF or OMFI Tracks 
into Pro Tools

To import AAF or OMFI tracks into Pro Tools:

1  Create a new Pro Tools session or open an ex-
isting session.

2  In Pro Tools 6.1, choose File > Import Session 
Data.

– or –

In Pro Tools 5.x, choose File > Import Tracks.

3  Select the AAF (Pro Tools 6.1 only) or OMFI se-
quence that contains the tracks you want to im-
port. 

In Pro Tools 6.1 you can drag and drop AAF 
or OMFI sequences from the Workspace 
browser to the Timeline.

Pro Tools does not support embedded AAF. 
AAF sequences with embedded media will 
display unknown in the Type column in 
DigiBase browsers.
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4  In Pro Tools 6.1, select the source tracks to be 
imported in the Import Session Data dialog.

– or –

In Pro Tools 5.x, select one or more tracks to im-
port from the list of tracks available in the Im-
port Tracks dialog.

Import Session Data dialog

Import Tracks dialog
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5  Select the desired AAF/OMFI translation set-
tings (see “AAF/OMFI Translation Settings” on 
page 24).

6  Select the desired Audio Media Options, if any 
(see “Audio Media Options” on page 25).

7  Select the desired Sample Rate Convert Op-
tions, if any (see “Sample Rate Convert Options” 
on page 26).

8  Select the desired Time Code Mapping Op-
tions, if any (see “Time Code Mapping Options” 
on page 27).

9  Select the desired Track Offset Options 
(Pro Tools 6.x only), if any (see “Track Offset Op-
tions” on page 28).

10  Click OK.

Importing OMFI Audio FIles to 
Tracks in Pro Tools
When you import audio to tracks, Pro Tools im-
ports the audio, creates a new track, and places 
the imported audio into the newly created track 
as well as the Regions List. The imported region 
will take its name and time stamp from the OMF 
data.

Shift-click to select multiple contiguous 
tracks, and Control-click (Windows) or 
Command-click (Macintosh) to select mul-
tiple non-contiguous tracks.

If there are any errors or region name trun-
cations, a dialog will appear asking you if 
you want a detailed report of the changes. 
Click Yes and choose where you want to 
save the log.



To import audio to tracks: 

1  Create a new Pro Tools session or open an ex-
isting session.

2  Choose File > Import Audio to Track.

3  In the Import Audio dialog, select the audio 
file you want to import. Its properties will be dis-
played in the lower left corner of the dialog, and 
its associated regions will be displayed in the 
middle of the dialog.

4  If the audio file is the same file format, sample 
rate, and bit-depth as the session, click Add.

– or –

If the audio file is a different file format, sample 
rate, or bit-depth as the session, click Convert.

In Pro Tools 6.x, drag and drop OMF audio 
files from any DigiBase browser to the 
Timeline.

Shift-click to select multiple contiguous 
tracks, and Control-click (Windows) or 
Command-click (Macintosh) to select mul-
tiple non-contiguous tracks.
Importing OMFI Audio into the 
Pro Tools Regions List

To import audio files or regions into the Regions 
List:

1  Create a new Pro Tools session or open an ex-
isting session.

2  Choose Import Audio from the Audio Regions 
List menu.

3  In the Import Audio dialog, select the audio 
file you want to import. Its properties will be dis-
played in the lower left corner of the dialog, and 
its associated regions will be displayed in the 
middle of the dialog.

4  If the audio file is the same file format, sample 
rate, and bit-depth as the session, click Add.

– or –

If the audio file is a different file format, sample 
rate, or bit-depth as the session, click Convert.

In Pro Tools 6.x, drag and drop OMF audio 
files from an DigiBase browser to the Re-
gions List.

Shift-click to select multiple contiguous 
tracks, and Control-click (Windows) or 
Command-click (Macintosh) to select mul-
tiple non-contiguous tracks.
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Importing Files From 
MediaManager into Pro Tools
(Windows XP and Mac OS 9 Only)

To import an audio or video file from 
MediaManager into Pro Tools:

1  Select the desired audio or video files, or se-
quence, in the MediaManager window in Inter-
net Explorer.

2  On Windows, drag and drop the selected au-
dio or video files, or sequence, from the Media-
Manager window in Internet Explorer onto the 
Pro Tools session.

– or –

On Macintosh (Mac OS 9 only), grab the Drag & 
Drop icon in the upper right-hand corner of the 
MediaManager window and drag it onto the 
Pro Tools session.

Dragging and Dropping

(MediaManager Only)

There are several ways to import media by 
dragging and dropping:

■ Audio files to the Regions List

■ Audio files to the Timeline

■ Video files to the Timeline

■ Sequences to the Timeline

If you attempt to import a video track from 
one session into another, and the frame 
rates of the two sessions do not match, a di-
alog will appear warning you that the video 
clip cannot be imported.
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Dragging and Dropping Audio Files to the 
Pro Tools Regions List

When you drag and drop an audio file directly 
to the Regions List, the new item will be high-
lighted in the Regions List.

Dragging and Dropping Audio Files to the 
Pro Tools Timeline

When you drag and drop an audio file to the 
Timeline, Pro Tools will create a new track for 
every file. Mono files create one track, multiple 
mono files create multiple tracks, and multi-
channel files (including stereo) create multi-
channel tracks.

When you drag and drop an audio file to the 
Timeline, the new items will be highlighted on 
both the track and in the Regions List.

Pro Tools automatically spots files that are 
dragged and dropped onto the Timeline to their 
respective time stamp location, unless that time 
stamp location cannot be located because it is 
outside the range of the Pro Tools session time-
line. If the time stamp location is outside the 
range of the Pro Tools session Timeline, Pro 
Tools will warn you. You will still be able to im-
port the selected files, but you won’t be able to 
maintain absolute time code values. In the im-
port dialog, select either Maintain Relative Time 
Code Values or select Map Start Time Code To 
from the Time Code Mapping Options pop-up 
menu.

Time Code Mapping Options



Dragging and Dropping Video Files to the 
Pro Tools Timeline

You can drag and drop a video file or an OMFI 
sequence referencing a video file directly onto 
the Timeline.

If the time stamp of the dropped video is equal 
to or greater than the session start time, 
Pro Tools spots the movie to the movie’s time 
stamp. (If there was no existing Movie track, 
Pro Tools will create one.)

If the time stamp of the dropped movie is less 
than the session start time, the Import Tracks 
box will appear automatically, so that you may 
enter a valid start time for the clip.

To spot a video file to a specific location other 
than the time stamp:

1  Alt-Drag and Drop (Windows) or Option-Drag 
and Drop (Macintosh) the file from MediaMan-
ager into Pro Tools. 

2  In Pro Tools 6.x, from the Import Session Data 
dialog, spot the movie by selecting Map Start 
Time Code To in the Time Code Mapping Op-
tions section of the Import Session Data dialog, 
then specify a time code value. 

– or –

In Pro Tools 5.x, from the Import Tracks dialog, 
spot the movie by selecting Map Start Time 
Code To in the Time Code Mapping Options 
section of the Import Tracks dialog, then specify 
a time code value.

This transposes all events in the source material 
by the difference between the mapped time 
code value and the source start time code. 

3  If there was a movie in the Movie track al-
ready, the new one replaces the original one (ex-
cept wherever the new one does not overlap).
To replace the original movie with the dropped 
movie:

1  Clear the Movie track.

2  Drag and drop the new movie onto the Movie 
track.

Dragging and Dropping OMFI Sequence Files to 
the Pro Tools Timeline

When you drag and drop OMFI sequence files 
from MediaManager to the Pro Tools Timeline:

• You import the entire sequence, including 
video. 

• You add new audio tracks in addition to any 
existing audio tracks. 

• Offline regions are supported. They appear as 
light blue.

• Video files are added to the Movie track in the 
same way as listed above.

You cannot drop a Meridien video file into a 
Pro Tools system that does not have an au-
thorized installation of AVoption|XL. If 
you attempt to do so, you will receive an er-
ror.

For more information on offline regions, re-
fer to the Pro Tools Reference Guide.

Pro Tools does not support embedded video 
files.
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Importing Mismatched Files and 
Sequences

The Import Tracks dialog appears when you 
drag and drop sequences or files from Media-
Manager, under the following conditions:

• There is a mismatch between the file sample 
rate and the session sample rate.

• There is a mismatch between the file bit depth 
and the session bit depth.

• The time stamp of the file is earlier than the 
session start time.

• If you hold down the Alt key (Windows) or 
Option key (Macintosh) while dragging the 
file. This allows you to spot files to a time code 
other than the file’s time stamp by using the 
Map Start Time window.

Import Options
When importing AAF or OMFI sequences, 
Pro Tools provides several import options 
through the Import Session Data dialog 
(Pro Tools 6.x) or Import Tracks dialog 
(Pro Tools 5.x):

• AAF/OMFI Translation Settings

• Audio Media Options

• Sample Rate Convert Options

• Time Code Mapping Options

• Track Offset Options (Pro Tools 6.x only)

If the time stamp of the file places it late 
enough in the sequence so that automation 
or other data extends more than approxi-
mately 12 hours past the session start time, 
that data will be dropped.
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AAF/OMFI Translation Settings

DigiTranslator 2.0 provides specific options for 
“translating” audio clips when importing AAF 
sequences or OMFI files and sequences.

Ignore Rendered Audio Effects

Enabling the Ignore Rendered Audio Effects op-
tion imports clips as audio regions without the 
rendered effects, such as EQ, that are applied to 
the clip. You might do this if you want to use 
Pro Tools audio effects and audio processing ex-
clusively for your audio post production work. 
The resulting audio with this setting is the un-
processed source material.

Clip-Based Gain

Media Composer and other Avid products pro-
vide clip-based gain to adjust the volume of an 
individual audio clip. This differs from Pro Tools 
volume adjustments for an entire track, or vol-
ume breakpoint automation. You can use Digi-
Translator’s Clip-Based Gain pop-up menu to 
map clip-based gain settings to Pro Tools break-
point automation, to process audio to include 
clip-based gain, or to ignore clip-based gain en-
tirely.

Ignore Clip-Based Gain

Use this setting to discard the project’s clip-
based gain settings, and adjust volume using 
Pro Tools mixing capabilities. 

Translation settings

Clip-Based Gain pop-up menu



Apply Clip-Based Gain Destructively

(Pro Tools 6.0 and 5.x Only)

Use this setting to process each audio clip using 
the clip-based gain settings from the source ap-
plication. New audio files are created that reflect 
the results of the clip-based gain.

You might want to use this feature for the fol-
lowing reasons:

• The stepped breakpoint automation resulting 
from Convert Clip-Based Gain to Volume Au-
tomation can be difficult to work with when 
remixing in Pro Tools.

• Stepped volume automation may result in au-
dio “pops.”

• Pro Tools cannot replicate “post-clip-based-
gain” crossfades using volume automation. In 
the Media Composer application, clip-based-
gain is applied to two clips, then the clips are 
crossfaded. However, when Pro Tools tries to 
replicate this with automation, the resulting 
regions have a volume automation ramp 
across the crossfade. As a result, Pro Tools 
breakpoint automation may not accurately re-
produce the original automation.

Convert Clip-Based Gain to Breakpoint 
Automation

Clip-based gain is translated to breakpoint auto-
mation in Pro Tools. Breakpoint automation is 
ramped across crossfades. Clip-based gain ex-
ceeding +6 dB will be ignored by Pro Tools.
Ignore Keyframe Gain

Enable the Ignore Keyframe Gain option to dis-
card the project’s keyframe gain settings. Dis-
able the Ignore Keyframe Gain option (it is dis-
abled by default) to translate keyframe gain to 
breakpoint automation in Pro Tools. Although 
Avid keyframe gain can add as much as 12 dB, 
only the first 6 dB will be translated to the 
Pro Tools session. 

Pan Odd Tracks Left/Even Tracks Right

Although pan automation is translated into 
Pro Tools pan automation breakpoints, a track’s 
default pan setting may not be translated (for 
example, from Media Composer). The Pan Odd 
Tracks Left/Even Tracks Right setting enables 
you to set the basic track pan setting so that 
odd-numbered tracks translate with full-left 
panning, and even-numbered tracks translate 
with full-right panning. This is useful if some or 
all of the audio does not have keyframe automa-
tion associated with it, and you want to pan the 
currently unpanned audio full-left or full-right.

Audio Media Options

When importing AAF or OMFI tracks into 
Pro Tools, use the Source Media pop-up menu to 
copy, consolidate, or refer to the source audio 
media.

Audio Media Options

Source Media pop-up (AAF or OMFI to Pro Tools)
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Refer to Source Audio Media (Where Possible)

This setting instructs DigiTranslator to translate 
the OMFI file to a Pro Tools session that refers to 
as many of the original media files as possible. 
In this case, the Pro Tools session points to the 
BWF (WAV), AIFC, or SDII files from the source 
project. This setting will not duplicate, copy, or 
make any duplicates of media.

Copy Source Audio Media

Use this setting to copy referenced audio to a 
new drive or folder. 

You can sample-rate convert the audio during 
this translation.

Consolidate Source Audio Media

Use this setting to copy the audio from the 
source project to the Pro Tools session, while re-
moving all unused areas in the copies. For exam-
ple, you may only be using ten seconds of a ten-
minute audio file in your project. Consolidating 
this audio saves a great deal of disk space by pre-
serving only the audio you use and a user-de-
fined amount of handle, and discarding the rest.

You can sample-rate convert the audio during 
this translation.

Consolidate Handle Length (ms)

If you have selected Consolidate Source Audio 
Media, you can specify the number of millisec-
onds of each original audio file to retain both 
before and after the region boundaries defined 
in the source project. This enables you to extend 
region boundaries even after you’ve consoli-
dated, by the amount you specify.

It’s a good idea to have at least 1000 millisec-
onds of handle, so you can “trim out” edits that 
sound “clipped” or “up-cut.”
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Force Audio Media to Target Session Format

Use this setting to convert source media to the 
session audio file format if the source media file 
format differs from the session file format.

Sample Rate Convert Options

These settings let you to convert the sample rate 
of the session’s audio files. For example, you can 
convert from 48 kHz to 44.1 kHz, or from 
44.1 kHz to 48 kHz. Pro Tools|HD systems sup-
port sample rates higher than 48 kHz (88.2 kHz, 
96 kHz, 176.4 kHz, and 192 kHz). These settings 
also enable you to convert to compensate for 
the 0.1% speed change (pull-up or pull-down) 
between 24 fps film and 29.97 fps NTSC video, 
or the 4% speed change (pull-up or pull-down) 
between 24 fps film and 25 fps PAL video.

Source Audio Sample Rate

This setting enables you to specify the sample 
rate of the material you are working with in 
Pro Tools, independent of the project sample 
rate settings.

For example, you may receive a project origi-
nated on Media Composer at 44.1 kHz. If you 
want to work at 48 kHz in Pro Tools, you should 
set the Source Audio Sample Rate setting to 
44,100 and the Destination Audio Sample Rate 
to 48,000.

Sample Rate Conversion Options

See Table 1 on page 45, for information 
about converting between different speeds 
and sample rates using DigiTranslator.



These settings can also be used to correct for 
pull-up or pull-down problems. For example, 
you may receive an OMFI transfer from a Film 
Composer that contains audio media at “film 
speed” when played back at 48 kHz. You may 
want to convert all the audio files and edits to 
play back at NTSC video speed and 48 kHz. 

In this case, set the Source Audio Sample Rate 
setting to 47,952 and the Destination Audio 
Sample Rate to 48,000. These settings tell Digi-
Translator that you want to fit 47,952 of the 
original “film speed” samples into 48,000 of the 
new “video speed” samples. With these settings, 
you sample-rate-convert the material to NTSC 
video speed. 

You can set the Source Audio Sample Rate either 
by selecting one of the predefined sample rates 
from the pop-up menu, or by typing a value into 
the text box.

Destination Audio Sample Rate

This setting determines the target session’s sam-
ple rate setting, as shown in the Session Setup 
window, and the sample rate of all audio files in 
the target session. Available settings include 
Pro Tools standard sample rates of 44.1 kHz or 
48 kHz. Pro Tools|HD systems support sample 
rates higher than 48 kHz (88.2 kHz, 96 kHz, 
176.4 kHz, and 192 kHz).

If this setting differs from the Source Audio Sam-
ple Rate setting, audio is sample-rate converted 
digitally to the Destination Audio Sample Rate.

See Table 1 on page 45, for information 
about converting between different speeds 
and sample rates using DigiTranslator.
Sample Rate Conversion Quality

These settings correspond to Pro Tools sample 
rate conversion settings. The “Tweak Head 
(Slowest)” setting provides the best results.

Time Code Mapping Options

You can specify where the imported tracks are 
placed in the current session. Times are indi-
cated in time code for TDM systems or Pro Tools 
LE 6.1 systems with the DV Toolkit option, and 
minutes:seconds for Pro Tools LE systems.

Maintain Absolute Time Code Values

This option places tracks at the locations where 
they were located in the source session. For ex-
ample, if the current session starts at 
00:01:00:00, and the session from which you are 
importing starts at 10:00:00:00, the earliest im-
ported tracks can appear in your session is 9 
hours and 59 minutes after the start of the ses-
sion.

Maintain Relative Time Code Values

This option places tracks at the same offset from 
session start as they had in the source session. 
For example, if the source session starts at 
01:00:00:00 and a contains a track that starts at 
01:01:00:00, and the current session start is 
02:00:00:00, the track will be placed at 
02:01:00:00 in the current session. 

Time Code Mapping Options
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Map Start Time Code to hh:mm:ss:ff

This option places tracks relative to their origi-
nal session start time. For example, if the cur-
rent session starts at 00:01:00:00, and the ses-
sion from which you are importing starts at 
10:00:00:00, you can reset the start time code to 
00:01:00:00, to avoid placing files 9 hours and 
59 minutes from the start of your session.

Track Offset Options
(Pro Tools 6.x Only)

Specify a track offset in addition to any offset in-
curred with the Time Code Mapping options. 
Any imported audio is offset in the current ses-
sion’s timeline by the specified amount. Values 
can be entered in Minutes:Seconds, Bars|Beats, 
Samples, Time Code, or Feet/Frames. 

Track Offset Options
DigiTranslator Integrated Option Guide



chapter 5

Exporting AAF and OMFI from Pro Tools
You can export OMFI files from Pro Tools with 
the DigiTranslator 2.0 Option using the Bounce 
to Disk, Export Selected as Files, and Export Se-
lected Tracks as OMFI (Pro Tools 6.0 and 5.x) 
commands. In Pro Tools 6.1 you can also export 
AAF and OMFI sequences using the Export Se-
lected Tracks as OMF/AAF command.

Pro Tools with the DigiTranslator 2.0 Option ex-
ports specific information about AAF sequences 
and OMFI files and sequences. AAF sequences 
and OMFI sequences and files exported from 
Pro Tools only retain time code addresses, re-
gion names, and definitions. 

AAF and OMFI sequences exported from 
Pro Tools do not support video files, or retain in-
formation about plug-ins’ assignments or pa-
rameters, routing, or grouping. It is recom-
mended that you render any effects prior to 
export. Pro Tools does export volume automa-
tion to AAF and OMF, but only if the Quantize 
edits to frames boundaries option (Avid Com-
patibility Mode) is disabled.

Export from Pro Tools to AAF is only sup-
ported in Pro Tools 6.1.
OMFI Export Options
• Publish As OMFI

• Enforce Avid Compatibility

• Checkin to Avid Unity MediaManager (if 
available)

Publish As OMFI

If the Publish As OMFI option is enabled, any 
files and sequences you export will contain the 
AAF or OMFI information required for inter-
change with Avid and other AAF or OMFI-com-
patible applications. 

To ensure OMFI compatibility:

■ File Type is limited to AIFF, BWF (.WAV), and 
SDII.

■ Bit-Depth is limited to 16-bit (Bit depth is not 
restricted in Pro Tools 6.1).

■ Format is limited to (Multiple) Mono.

■ When you Bounce to Disk, Convert After 
Bounce is forced.

Enforce Avid Compatibility

If the Enforce Avid Compatibility option is en-
abled, all OMFI files and sequences will meet the 
specific requirements of Avid Video worksta-
tions.
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When Enforce Avid Compatibility is enabled:

• In Pro Tools 5.x or 6.0, bit-depth is limited to 
16-bit.

• Sample rates are limited to 44.1 kHz or 
48 kHz.

• When exporting an OMFI sequence from 
Pro Tools, exported regions will be padded to 
the nearest frame boundaries. While Pro Tools 
allows sample-accurate editing of up to 
1/192,000th of a second with Pro Tools|HD 
systems, many video editing systems only al-
low edits on frame boundaries (depending on 
the frame rate, approximately every 30th of a 
second). This padding ensures that the place-
ment of a file in the Timeline will be the same 
on sample-accurate as well as frame-accurate 
systems.

Checkin To MediaManager

(Avid Unity MediaNetwork or MediaNet)

If the Checkin To MediaManager option is en-
abled, all exported files and sequences will be 
checked in to the MediaManager database. See 
Chapter 3, “Working with Avid Unity Media-
Manager (Mac OS 9 and Windows XP Only).”

Checkin to MediaManager only appears if your 
Pro Tools session is currently logged in to a Me-
diaManager system.

This box must be checked if you are storing files 
on a MediaNetwork or MediaNet workspace us-
ing MediaManager.

Pro Tools 6.1 supports both 16-bit or 24-bit 
for AAF and OMF export when Enforce Avid 
Compatibility is enabled. Avid Media Com-
poser Adrenaline and Nitris support 24-bit 
audio, but earlier Avid systems only support 
16-bit audio.
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To ensure MediaManager compatibility:

■ The destination directory for the files you are 
exporting must be a MediaNetwork or MediaNet 
directory.

■ SDII is grayed out in the File Type menu. You 
cannot check SDII files into MediaManager di-
rectly from Pro Tools. MediaManager does not 
support OMFI SDII files exported from 
Pro Tools.

Publishing Options
When exporting OMFI files from Pro Tools, spe-
cific OMFI and MediaManager publishing op-
tions that provide information about the OMFI 
sequence or media are available through the 
Publishing Options dialog. These options will 
vary depending on which method of exporting 
OMFI files you use, and whether or not you are 
logged in to MediaManager.

Publishing Options window (Pro Tools 5.1.3)



OMFI Options

Tape Name (Pro Tools 5.1.3) Identifies the 
source of the file, and defaults to the name of 
the current session. The Tape Name field does 
not appear if you are using the Export Selected 
as Tracks command, since audio on one track 
may have many different sources.

Pro Tools Comment (Pro Tools 5.3.1 or 
later) Identifies the source of the file, and de-
faults to the name of the current session. The 
Pro Tools Comment field does not appear if you 
are using the Export Selected as Tracks com-
mand, since audio on one track may have many 
different sources.

Clip Name This is the name that will be dis-
played when the file is imported into another 
OMFI-compatible program. The clip name is not 
the file name that will appear in the finder. This 
field defaults to the Pro Tools region name. 
When exporting more than one region, all clip 
names are automatically set to the region name.

Target Project Time Code Format Select the time 
code format for the project into which this file 
or sequence will be imported. This may be dif-
ferent from the time code format of the current 
session. This parameter allows regions to be 
placed correctly in sessions with different time 
code formats, and also calculates how many 
samples must be added to pad regions to frame 
boundaries.
MediaManager Options

(Windows XP and Mac OS 9 Only)

If you are checking in to MediaManager, the fol-
lowing fields will also appear:

Project Name If you enter the name of an exist-
ing MediaNet project, the file will be stored with 
the corresponding project. If you enter a name 
of a project that does not exist, one will be cre-
ated.

Bin Name If you enter the name of a bin that al-
ready exists (as part of the project entered in the 
Project Name field), the file will be stored in the 
corresponding bin. If you enter a bin name that 
does not already exist, one will be created.

Comments Any comments you enter in this field 
will appear in the Information window in the 
MediaManager browser interface and in the 
Comments field of the Avid bin when the se-
quence or file is imported into an Avid system.

Bounce to Disk
(OMFI Only)

Use the Bounce to Disk command to export se-
lections of all audible audio from the Timeline 
to OMFI. This method is useful for rendering 
real-time plug-ins and automation on export.
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To export to OMFI using Bounce to Disk:

1  In Pro Tools, prepare the session for bouncing 
to disk and make the desired selection to bounce 
to disk.

2  Choose File > Bounce to Disk.

3  Select Publish as OMFI.

4  If desired, select Enforce Avid Compatibility.

5  If using MediaManager, select Check In to 
MediaManager.

6  Click Bounce to open the Publishing Options 
window.

7  In the Publishing Options dialog (Pro Tools 
5.1.3), enter the Tape Name and Clip Name, and 
select the Target Project Time Code Format.

– or –

Bounce dialog

Enforce Avid Compatibility limits the sam-
ple rate options to 44.1 or 48 kHz, and lim-
its the bit depth to 16 (24-bit is also avail-
able in Pro Tools 6.1). Dithering without 
noise shaping will be applied to files being 
exported from 24-bit to 16-bit.
DigiTranslator Integrated Option Guide
In the Publishing Options dialog (Pro Tools 
5.3.1 or later), enter the Pro Tools Comment 
and Clip Name.

– or –

If checking in to MediaManager, enter the Tape 
Name (Pro Tools 5.1.3) or Pro Tools Comment 
(Pro Tools 5.3.1 or later), Clip Name, and 
MediaManager Options (Project Name, Bin 
Name, and Comments).

8  Click OK to complete the export.

All audible audio in the selection will be ex-
ported to multi-mono OMF files.

Refreshing MediaNetwork 
Database Files

In a MediaManager environment, all files you 
want to export to another system must be 
checked in to MediaManager. If they are not 
checked in to MediaManager, they cannot be 
seen by other systems. In a MediaManager envi-
ronment, Avid video workstations rely on 
MediaManager to track files.

Publishing Options

Publishing Options using MediaManager



In a non-MediaManager environment, each 
Avid on a MediaNetwork or MediaNet system 
“owns” a subfolder of OMFI media files. Only 
the Avid that owns the folder can update the file 
database for that folder. If the database isn't up-
dated, the workstations cannot see the media. 
However, once the MediaNetwork or MediaNet 
database is updated, all workstations will be able 
to see the media.

For example, to export a bounced mix of a 
Pro Tools session to an Avid workstation:

1  Choose File > Bounce to Disk. 

2  Select the OMFI media folder that belongs to 
the target Avid workstation on the MediaNet-
work or MediaNet system.

3  Bounce to that folder.

The Avid workstation will need to refresh its da-
tabase to include the exported files. Once these 
steps have been completed, all Avid systems on 
the MediaNetwork or MediaNet system will be 
able to see the exported files. 

Export Selected as Files
(OMFI Only)

Use the Export Selected as Files command to ex-
port individual regions from the Regions List in 
OMFI format. Regions exported to OMFI from 
the Regions List will not render any real-time ef-
fects (plug-ins) or track automation.
To export selected regions as files:

1  Select the regions you want to export in the 
Regions List.

2  Choose Export Selected as Files from the Au-
dio Regions List pop-up menu.

3  From the Export Selected dialog, check Pub-
lish as OMFI.

4  If desired, select Enforce Avid Compatibility.

Shift-click to select multiple regions.

Export Selected as Files dialog

Enforce Avid Compatibility limits the sam-
ple rate options to 44.1 or 48 kHz, and lim-
its the bit depth to 16 (24-bit is also avail-
able in Pro Tools 6.1). Dithering without 
noise shaping will be applied to files being 
exported from 24-bit to 16-bit.
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5  If using MediaManager, select Check In to 
MediaManager.

6  Select a location for the Destination Directory. 
If checking in to MediaManager, this must be a 
location on the MediaNet workspace.

7  Clicking Export will open the Publishing Op-
tions window.

8  In the Publishing Options dialog, enter the 
Tape Name (Pro Tools 5.1.3) or Pro Tools Com-
ment (Pro Tools 5.3.1 or later) and Clip Name, 
and select the Target Project Time Code Format. 
If you selected more than one region for export, 
the Clip Name field will not be available and 
DigiTranslator will use the names of the regions 
for the exported files.

9  Click OK to complete the export.
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Export Selected Tracks as 
OMF/AAF 
(Exporting Pro Tools Sessions as AAF and 
OMFI Sequences)

Use Export Selected Tracks as OMF/AAF to ex-
port individual tracks or an entire Pro Tools ses-
sion in AAF or OMFI format.

Export from Pro Tools to AAF is only sup-
ported in Pro Tools 6.1.

Tracks are exported in their entirety and 
time selections are ignored.

Volume and pan automation is not re-
tained on export if Quantize Edits to Frame 
Boundaries is enabled (Avid Compatibility 
Mode).

The Movie track cannot be exported to AAF 
or OMFI from Pro Tools.



To export selected audio tracks as an AAF or OMFI 
sequence:

1  In Pro Tools, select the tracks you want to ex-
port. 

2  In Pro Tools 6.1, choose File > Export Selected 
Tracks as OMF/AAF.

– or –

In Pro Tools 6.0 or earlier, choose File > Export 
Selected Tracks as OMFI.

3  In Pro Tools 6.1, select AAF or OMF from the 
Export As pop-up menu.

Shift-click to select multiple tracks. Alt-click 
(Windows) or option-click (Macintosh) to 
select all tracks.

Export Selected Tracks as OMF
4  If desired, select Enforce Avid Compatibility.

5  If using MediaManager, select Check In to 
MediaManager.

6  Select other options as desired (see “Transla-
tion Settings” on page 36).

7  Click OK. The Publishing Options dialog ap-
pears. 

8  Enter the Pro Tools Comment (Pro Tools 5.3.1 
or later only) and Sequence Name.

9  If you selected Checkin To MediaManager, en-
ter the Project Name, Bin Name, and Com-
ments.

10  Click OK. 

11  Select the directory where you want to save 
the AAF or OMFI sequence.

12  Click OK to complete the export.

Enforce Avid Compatibility limits the sam-
ple rate options to 44.1 or 48 kHz, and lim-
its the bit depth to 16 (24-bit is also avail-
able in Pro Tools 6.1). Dithering without 
noise shaping will be applied to files being 
exported from 24-bit to 16-bit.

Publishing Options using MediaManager (Mac OS 9)
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To check a sequence into MediaManager 
(Windows and Mac OS 9 only), when files in that 
sequence do not reside on the same 
MediaNetwork workspace:

1  In Pro Tools, select the tracks you want to 
check in to MediaManager.

2  Choose File > Export Selected Tracks as OMFI.

3  In the Export to OMF dialog, enable the Check 
in to MediaManager option.

4  From the Audio Media Options pop-up menu, 
select Refer to Source Media. Any referenced file 
that does not reside on the MediaNet workspace 
will automatically be copied to it when the ex-
port is completed.

5  Select other options as desired.

6  Click OK.

7  Choose the location to store the newly copied 
files on the MediaNetwork or MediaNet work-
space.

8  Click OK to complete the export. 

9  From the resulting dialog, check the “Would 
you like to relink your session to the files on Me-
diaNet?” box. 

Shift-click to select multiple tracks. Alt-click 
(Windows) or option-click (Macintosh) to 
select all tracks.

There is no Undo command once you choose 
to relink your session to the files on Media-
Net. As a safety precaution, you may want 
to save the session immediately before 
checking it into MediaManager. In this 
case, if you relink the session by mistake, 
you can always revert to the saved session.
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Translation Settings

DigiTranslator 2.0 provides several translation 
settings when exporting tracks to OMF/AAF, in-
cluding OMFI/AAF Options, Sample Rate Con-
version Options, and Audio Media Options.

OMFI/AAF Options

Enforce Avid Compatibility

If the Enforce Avid Compatibility option is en-
abled, all AAF sequences and OMFI files and se-
quences will meet the specific requirements of 
Avid Video workstations. Bit-Depth is limited to 
16-bit (Pro Tools 6.1 will not limit Bit-Depth) 
and sample rates are limited to 44.1 kHz or 
48 kHz. Exported regions will be padded to the 
nearest frame boundaries (Quantize Edits to 
Frame Boundaries). This padding ensures that 
the placement of a file in the Timeline will be 
the same on sample-accurate as well as frame-ac-
curate systems. 

Target Project Time Code Format

Select the time code format for the project into 
which this file or sequence will be imported. 
This may be different from the time code format 
of the current session. This parameter allows re-
gions to be placed correctly in sessions with dif-
ferent time code formats, and also calculates 
how many samples must be added to pad re-
gions to frame boundaries.

Export to OMFI/AAF Options



Quantize Edits to Frame Boundaries

Pro Tools allows sample-accurate placement of 
regions. In Pro Tools, you can place a region of 
any length at any position, without any require-
ment for aligning regions with frame bound-
aries.

However, most video editing programs, such as 
Media Composer, only support frame-accurate 
editing. In these programs, you can only edit 
sounds on whole frame boundaries, limiting 
your precision.

Selecting Enforce Avid Compatibility will auto-
matically select Quantize Edits to Frame Bound-
aries.

The Quantize Edits to Frame Boundaries setting 
allows DigiTranslator to export your sample-ac-
curate Pro Tools edits into an OMFI file so they 
appear as frame-accurate. See Figure 3 through 
Figure 6 on page 37.

The Quantize Edits to Frame Boundaries 
setting must be selected when you are trans-
lating your Pro Tools session for use in 
frame-accurate editing workstations. There-
fore, it is automatically selected whenever 
you export tracks with Enforce Avid Com-
patibility checked.
When you quantize edits to frame boundaries, 
you must enter the desired handle length (under 
Audio Media Options). See “Consolidate Handle 
Length (ms)” on page 39.

A master clip consisting of the region plus the 
handle length on both front and back will be ex-
ported. The exported sequence creates a subclip 
which is equivalent to the original region, but 
extended to the farthest frame boundaries. For 
example, if the region starts at 1:15 and 500 
samples, the subclip would start at 1:15; and if 
the region ends at 4:00 and 500 samples, the 
subclip would end at 4:01.

Because quantizing edits to frame boundaries 
extends the regions, extra undesired audio may 
be heard. To prevent this extra audio from play-
ing, special one-frame sound files are rendered 
to duplicate the original boundaries of the re-

Figure 3.  Original region

Figure 4.  Region exported with handles

Figure 5.  Subclip: Region stretched to farthest frame 
boundaries

Figure 6.  Subclip with OFFs (One Frame FIles) laid over 
end frames
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gion. In the exported sequence, these one-frame 
files are placed over the start and end frames of 
the extended region so you cannot hear the ex-
tension.

One-frame files (OFFs) are imported into Avid 
workstations as part of the OMFI sequence like 
any other sound file. In the Avid Timeline, they 
appear as one-frame edits on either side of a sub-
clip.

If you decide you need to extend the subclip at 
any point, discard the OFF and trim the subclip 
as needed.

Sample Rate Conversion Options

These settings allow you to convert the sample 
rate of your Pro Tools session during export to 
AAF or OMFI by sample-rate converting each au-
dio file, and adjusting the edits in the resulting 
AAF or OMFI file to compensate for this change.

This solution is only available when you ex-
port a sequence, not when you export indi-
vidual files. 

If Quantize Edits to Frame Boundaries is se-
lected, Pro Tools volume automation will 
not be exported.

Sample Rate Conversion Options

See Table 1 on page 45, for information 
about converting between different speeds 
and sample rates using DigiTranslator.
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You may want to change the sample rate of a 
session if you are exporting to a system or are at 
a stage in the process that requires a different 
sample rate.

Alternately, in Pro Tools 5.1.3, use sample rate 
conversion to adjust for speed changes such as 
pull-up or pull-down. In Pro Tools 5.3.1 or later, 
check the Audio and Video pull options before 
applying a sample rate conversion to the entire 
session.

As another example, you might use Sample-Rate 
Conversion if you record and edit 48 kHz voice-
over files in sync with 29.97 fps video, then 
need to export these edited files to a Film Com-
poser system that plays back at 24 fps and 
44.1 kHz.

In this case, set the Source Audio Sample Rate 
setting to 48 kHz and the Destination Audio 
Sample Rate to 44.1 kHz. These settings tell 
DigiTranslator that you want to fit 48,000 of the 
original “video speed” samples into 44,100 of 
the new “film speed” samples. With these set-
tings, you instruct DigiTranslator to pull up the 
material to film speed and sample-rate convert 
to 44.1 kHz.

Source Audio Sample Rate

This setting allows you to specify the sample 
rate of the material you are working with in 
Pro Tools, independent of the session’s sample 
rate settings.

Destination Audio Sample Rate

This setting allows you to specify the sample 
rate for audio files after the AAF or OMFI trans-
lation. 

If this setting differs from the Source Audio Sam-
ple Rate setting, audio is sample-rate converted 
digitally to the Destination Audio Sample Rate.



Sample Rate Conversion Quality

These settings correspond to Pro Tools sample 
rate conversion settings. It is not recommended 
that you use the “Low (Fastest)” setting. The 
“Tweak Head (Slowest)” setting provides the 
highest quality sample rate conversion.

Audio Media Options

Audio Format

Choose whether you want the resulting OMFI 
file to refer to BWF (.WAV), AIFF, Sound De-
signer II (Macintosh only), or embedded files. 
The audio files will be converted accordingly.

Audio Bit-Depth

Select 16-bit or 24-bit as the target bit-depth for 
the exported media. Pro Tools will apply the Au-
dioSuite dithering algorithm, without noise 
shaping, when reducing bit-depth from 24-bit 
to 16-bit.

Source Media

When exporting tracks from Pro Tools to OMFI, 
there are three ways that DigiTranslator can 
handle source audio media (as set in the Export 
to OMF/AAF dialog’s Audio Media Options pop-
up menu).

Audio Media Options

If you create AIFF or BWF (.WAV) audio, 
the audio files have extra OMFI data at-
tached to them. Though most applications 
will not have problems reading these audio 
files, they may not be compatible with all 
applications.
Refer To Source Media Creates an OMFI file that 
refers to as many of the original media files as 
possible. In this case, the OMFI file points to the 
BWF (.WAV), AIFC, or Sound Designer II files 
from the source project.

Copy From Source Media Copies audio to an-
other drive or folder. You can sample-rate con-
vert the audio during this translation.

Consolidate From Source Media Copies only the 
part of the files that are actually used by the ses-
sion. For example, you may only be using a ten 
second region of a ten-minute audio file in your 
session. Consolidating this audio saves a great 
deal of disk space by copying only the audio you 
use, and discarding the rest. 

Consolidate Handle Length (ms) Specifies the 
number of milliseconds of the original audio file 
to retain at the beginning and end of each audio 
clip that is created. This allows you to extend 
clip boundaries even after you’ve consolidated, 
by the amount you specify. It’s a good idea to 
have at least 1000 milliseconds (one second) of 
handle, so you can “trim out” edits that sound 
“clipped” or “up-cut.” Consolidate Handle 
Length is only available when Consolidate From 
Source Media is selected.

Consolidate Source Audio Media is the only 
usable option for a Pro Tools to OMFI trans-
lation when Quantize Edits to Frame 
Boundaries is selected. See “Quantize Edits 
to Frame Boundaries” on page 37.
Chapter 5: Exporting AAF and OMFI from Pro Tools 39



40
Time Stamping
When you export to AAF or OMF, all exported 
OMFI media is time stamped. A time stamp is a 
specific time code location stored within an in-
dividual media file.

The time stamp can indicate:

■ Time Code location on the source tape

■ Where the file was originally recorded in the 
Pro Tools Timeline

■ Where a region was placed in an Avid or 
Pro Tools Timeline

■ User entered time codes

Time stamps can be stored in three different 
places within a media file:

■ In a region definition

■ In the file format metadata (for 
example, .WAV file wrappers)

■ In the AAF or OMFI wrapper

Exporting a Region

If you are exporting a region, the time stamp 
will be the start point of the region, relative to 
the point where the file originally started to 
record. For example, if you record a file from 
1:00 to 1:30, then trim it to start at 1:15, the 
time stamp for the exported region would be 
1:15. This is true even if the region is slipped 
elsewhere in the Timeline.

Exporting a Region as Part of a 
Sequence

When you export a region as part of a sequence, 
the region’s original time stamp reflects the re-
gion’s position in the Timeline of the sequence.
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Exporting a File

Recorded in Pro Tools If the file was recorded in 
Pro Tools, the time stamp is the location in the 
Timeline at which the recording began. For in-
stance, if you record the file from 1:00 to 2:00, 
the time stamp would be 1:00.

AudioSuite with Playlist If the file was created by 
AudioSuite, using the Playlist option, the time 
stamp is the location in the Timeline to which 
the source region was spotted. For example, if 
you record a file from 1:00 to 2:00, then move it 
to start at 4:00, the file would be duplicated, 
processed with the plug-in and the new time 
stamp for the duplicate would be 4:00.

AudioSuite with Region List If the file was cre-
ated by AudioSuite, using the Region List op-
tion, the time stamp reflects the original time 
stamp of the source file. For example, if you 
record a file from 1:00 to 2:00m then trim it to 
start at 1:15, the file is duplicated, processed 
with the plug-in, and the new time stamp is 
1:15.

Existing Time Stamp If a file is imported with an 
existing time stamp, it will remain the time 
stamp for the exported file as well. If the original 
file contained a time stamp in the format wrap-
per, it will be copied to the OMFI wrapper when 
exported.

Exporting a File With No Time Stamp

If you import a file that does not contain a time 
stamp (such as a sound effect from a CD), the 
time stamp will be 0 when it is exported.



Importing Files from an Avid AAF or 
OMFI Session

If you import a file from an Avid AAF or OMFI 
session, the media file's source tape time stamp 
becomes the original time stamp of the new 
Pro Tools file. The User Time Stamp maintains 
the original time stamp.

In Pro Tools 6.1, DigiBase provides columns 
for specific Avid OMF metadata, including: 
Clip Name, Tape, FPS, Original Times-
tamp, and User Timestamp.
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appendix a

DigiTranslator Reference Information
Translation Notes File
If there are any errors, region name truncations, 
or other notes (such as missing effect render-
ings), during import of an AAF sequence or 
OMFI file or sequence, a dialog appears asking if 
you want a detailed report of the changes. Click 
Yes and choose where you want to save the 
translation notes file.

The Translation Notes File can be opened by 
most word processing applications that can read 
plain text files.

Translation Notes Format

Translation Notes are presented in the following 
format:

Track Name <Timecode Start–Timecode End> “clip 
name (if available)”; message
Translation Notes and Categories

The Translation Notes File is separated into dif-
ferent categories. The following are sample mes-
sages in each category, with explanations of 
what has happened and solutions if necessary.

Parsing Errors

Example

A1<01:00:00:00–01:00:04:20>
error reading component “Assertion in 
OMF_Objects2x.cpp”, line 2871;
substituting fill

This error indicates a problem that may have 
originated in DigiTranslator or the application 
that produced the OMFI file. In the translated 
composition, there will be silence or video black 
at the given interval.

Missing Renderings

Example 1

A1<01:00:02:00–01:00:07:01>
no rendering for effect:EFF_AUDIO_EQMB;
using bypass clip

This indicates the presence of an effect for 
which there is no rendering. The “bypass clip” is 
the (unprocessed) source material for the effect. 
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Example 2

V1<01:00:48:25–01:00:49:26>
no rendering for effect: omfi:effect:
VideoRepeat;substituting silence/video black

For some effects, the length of the output is dif-
ferent than the length of the input. In this case, 
substituting a bypass when a rendering is miss-
ing doesn't make sense since it won't sync prop-
erly, so DigiTranslator substitutes silence or 
video black.

Ignored Effects

A1<01:00:02:00–01:00:07:01>
ignoring rendering for effect: 
EFF_AUDIO_EQMB;using bypass clip.

This indicates that the user has selected “Ignore 
Rendered Audio Effects” in DigiTranslator. This 
note is a convenience so that if something is 
odd in the translated sequence, the user can de-
termine if an effect that was ignored is actually 
required.

Incomplete Rendering

A1<00:00:28:29-00:00:31:17>incomplete render-
ing for effect; using bypass clip.A2<00:00:28:29-
00:00:31:17>incomplete rendering for effect Audio 
MultiBand EQ; using bypass clip.

This indicates that an effect was not rendered 
completely at a fade boundary in an Avid sys-
tem. On import, Pro Tools bypassed the incom-
plete rendering and imported the audio without 
the effect. If you need the effect, re-render the 
effect and fade on the Avid, and then export 
again.
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Truncated Names

Example

A1<01:00:02:02–01:00:07:01>
“Jag film to Whirl.01.Sub.03.new.01”=>
“Jag film to Whirl.01.Sub.03”

Pro Tools limits clip names to 31 characters, 
while Media Composer (and OMFI) have no 
limitation on clip name length. These entries 
enable you to determine which clip a given 
Pro Tools region represents if the name has been 
truncated.

Miscellaneous Errors (Misc Errors)

Example

A1<01:00:00:00–01:00:16:06>
“Jag film to Whirl.01.Sub.06.new.01”;
insufficient source material for clip;
shortening clip by 1 sample

This Translation Note is primarily informa-
tional, informing you that DigiTranslator was 
not able to translate the OMFI sequence exactly, 
and has had to make an adjustment so Pro Tools 
can understand it.

This error occurs because applications don’t al-
ways calculate the number of samples in a frame 
in the same way. In some cases, there may be 
one too few samples of media to support a given 
clip from the Pro Tools standpoint. In this situ-
ation, there can potentially be an audio “pop.” 



Speed Correction for Film, NTSC Video, and PAL Video Using 
DigiTranslator
 

Table 1. Speed Correction with DigiTranslator
Source Material 
Playback Speed

Desired 
Playback Speed

Starting Sample 
Rate

Source Sample 
Rate Setting in 
DigiTranslator

Film
30 fps

NTSC Video
29.97 fps

44,100 Hz 44,056 Hz

48,000 Hz 47,952 Hz

88,200 Hz 88,112 Hz

96,000 Hz 95,904 Hz

176,400 Hz 176,224 Hz

192,000 Hz 191,808 Hz

Film
24 fps

PAL Video
25 fps

44,100 Hz 45,938 Hz

48,000 Hz 50,000 Hz

88,200 Hz 91,875 Hz

96,000 Hz 100,000 Hz

176,400 Hz 183,750 Hz

192,000 Hz 200,000 Hz

NTSC Video
29.97 fps

Film
30 fps

44,100 Hz 44,144 Hz

48,000 Hz 48,048 Hz

88,200 Hz 88,288 Hz

96,000 Hz 96,096 Hz

176,400 Hz 176,576 Hz

192,000 Hz 192,192 Hz
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PAL Video
25 fps

Film
24 fps

44,100 Hz 42,336 Hz

48,000 Hz 46,080 Hz

88,200 Hz 84,672 Hz

96,000 Hz 92,160 Hz

176,400 Hz 169,344 Hz

192,000 Hz 184,320 Hz

Table 1. Speed Correction with DigiTranslator

Source Material 
Playback Speed

Desired 
Playback Speed

Starting Sample 
Rate

Source Sample 
Rate Setting in 
DigiTranslator
In Pro Tools, set the Destination Sample 
Rate to the desired target sample rate.
DigiTranslator Integrated Option Guide



appendix b

Avid Export Workflows
OMFI Export Workflow
The following OMFI export workflow illustrates 
how you should export an OMFI sequence from 
Avid Media Composer or Symphony. The set-
tings described are used with Avid Media Com-
poser 7.2 and Symphony 1.1. Consult your Avid 
documentation for the exact settings available 
in your product.

Exporting to an OMFI File

When exporting to an OMFI file, you can refer-
ence the media externally, or you can embed it. 
You may also want to consolidate, if you are 
moving the files to transportable media.

Consolidating Media

Before exporting to an OMFI file with video and 
audio, you’ll usually want to consolidate media 
referenced by the sequence. This creates a copy 
of the audio and video files and places them in a 
new location, making it easier to transport the 
media to other systems.

Since Consolidate is a destructive com-
mand, it is highly recommended that you 
duplicate your sequences into a new bin be-
fore consolidating. This ensures that the 
original sequence and the media it refer-
ences, remain intact.
Consolidating also removes any unused data 
from the new media, ensuring smaller OMFI 
files when exporting.

To export an OMFI file with external media from 
Media Composer:

1  Create a new bin.

2  Select the sequence.

3  Choose Edit > Duplicate to make a copy of the 
sequence in the new bin, so the original remains 
intact.

4  As desired, choose Clip > Consolidate to place 
a copy of the relevant media files (both audio 
and video) to the new bin.

5  Choose File > Export. In the Export dialog, se-
lect OMFI Composition with the following op-
tions:

• For the OMFI file type, select “Standard-
AIFC.”

• To specify which data is exported, select 
“Video and Audio.”

• For the OMFI version, select OMFI 2.0 and 
make sure “With Media” is deselected.

6  Click OK to export an OMFI file that will ref-
erence external media files.
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To export an OMFI file with embedded media from 
Media Composer:

1  Create a new bin.

2  Select the sequence.

3  Choose Edit > Duplicate to make a copy of the 
sequence in the new bin, so the original remains 
intact.

4  Be sure to Consolidate the media with han-
dels. Consolidating also ensures that only the 
media used in the sequence is exported and em-
bedded with the OMFI file.

5  Choose File > Export. In the Export dialog, se-
lect OMFI Composition with the following op-
tions:

• For the OMFI file type, select “Standard-
AIFC.”

• To specify which media is exported, select 
“Audio Only.”

• For the OMFI version, select OMFI 2.0 and 
make sure “With Media” is selected.

6  Click OK to export an OMFI file with the au-
dio media embedded. All audio contained in the 
OMFI file is written in the AIFC audio format.

Pro Tools supports embedded audio, but 
not embedded video.
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Exporting for Avid Symphony
(Macintosh Only)

Avid Symphony does not recognize Apple HFS 
drives. Therefore, if you are exporting files or a 
sequence for use on an Avid Symphony, you 
will need to complete some additional steps.

To prepare a file or sequence for use on an Avid 
Symphony:

1  Export the file or sequence from the Pro Tools 
session to the HFS drive.

2  Mount the HFS drive on the Symphony work-
station with MacOpener.

3  Drag the files to a drive your Symphony work-
station will recognize. This is easier if the OMF 
sequence already has the media embedded.

4  Launch Symphony and import the files.



OMFI Export Workflow 
(from Media Composer)
Figure 7.  Media Composer OMFI export workflow
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